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IMPORTANT NOTICE
DISCLAIMER OF WARRANTY
Epson America makes no representations or warranties, either express or
implied, by or with respect to anything in this manual, and shall not be liable for
any implied warranties of merchantability and fitness for a particular purpose or
for any indirect, special, or consequential damages. Some states do not allow the
exclusion of incidental or consequential damages, so this exclusion may not
apply to you.
COPYRIGHT NOTICE
All rights reserved. No part of this publication may be reproduced, stored in a
retrieval system, or transmitted, in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written
permission of Epson America, Inc. No patent liability is assumed with respect to
the use of information contained herein. Nor is any liability assumed for
damages resulting from the use of the information contained herein. Further,
this publication and features described herein are subject to change without
notice.
TRADEMARKS
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON
CORPORATION.
PhotoPC, ColorTrue, EPSON SoundAdvice, and EPSON FaxAdvice are
trademarks of Epson America, Inc.
Sierra Imaging is a registered trademark and Image Expert and Camio are
trademarks of Sierra Imaging, Inc. in the United States and other countries and
are used under license.
General notice: Other product names used herein are for identification purposes
only and may be trademarks of their respective owners. EPSON disclaims any
and all rights in those marks.
Copyright © 1997 by Epson America, Inc.
Torrance, California, USA
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A NOTE CONCERNING RESPONSIBLE USE OF
COPYRIGHTED MATERIALS
Digital cameras and scanners, like photocopiers and conventional cameras, can
be misused by improper copying of copyrighted material. While some countries’
laws permit limited copying of copyrighted material in certain circumstances,
those circumstances may not be as broad as some people assume. EPSON
encourages each user to be responsible and respectful of the copyright laws when
using digital cameras and scanners.
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FCC COMPLIANCE STATEMENT
FOR AMERICAN USERS
This equipment has been tested and found to comply with the limits for a
class B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio and television reception.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the
user is encouraged to try to correct the interference by one or more of the
following measures:

WARNING
The connection of a non-shielded equipment interface cable to this equipment
will invalidate the FCC Certification of this device and may cause interference
levels that exceed the limits established by the FCC for this equipment. It is the
responsibility of the user to obtain and use a shielded equipment interface cable
with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces.

◗

Reorient or relocate the receiving antenna

◗

Cet appareil numérique de la Classe B respecte toutes les exigences du
Reglement sur le materiel brouilleur du Canada.

Increase the separation between the equipment and receiver

◗

Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected

◗

Consult an experienced radio/TV technician for help.

Changes or modifications not expressly approved by the manufacturer could
void the user’s authority to operate the equipment.
FOR CANADIAN USERS
This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.
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Introduction
our new EPSON PhotoPC™ 550 is a high-quality,
easy-to-use digital camera. PhotoPC 550 captures
brilliant pictures in 24-bit color at true VGA resolution
(640 × 480 pixels). Your PhotoPC 550 comes complete with
a cable, batteries, software, and utilities for downloading,
editing, organizing, and printing your pictures. You can even
expand the camera’s capacity with optional 3.3V SSFDC
(solid state floppy disc card) or SmartMedia storage cards.

Y

Use PhotoPC 550 to add pictures to your documents, flyers,
and presentations to increase their visual impact. Create
personalized greeting cards. Share pictures with business
colleagues or friends over the Internet. Add pictures to your
web page.
PhotoPC 550 also has a built-in microphone so you can
annotate your pictures with sound or add a voice message,
allowing you to send multimedia e-mail.
Introduction 1
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PhotoPC 550 Features
PhotoPC 550 comes with everything you need to capture
digital images and includes the following:

Your camera comes with the PhotoPC 550 software suite,
which includes the following applications:
◗

Sierra Imaging Image Expert™ software for
transferring, organizing, editing, and printing your
pictures. You can also use it to play back your recorded
messages and record new messages for your pictures.

◗

TWAIN driver for downloading your pictures into
TWAIN compliant applications such as Adobe
Photoshop or CorelDraw

◗

Resolutions up to 640 × 480 pixels

◗

24-bit color images in more than 16 million colors

◗

1MB internal flash memory that holds 24 standard
resolution images

◗

Macro mode (close-up) picture taking

◗

Highly light sensitive CCD (charge coupled device)
sensor (no need for flash)

Optional Accessories

◗

Automatic shut-off to save batteries

◗

◗

Date and time information saved with each picture

PhotoPC AC adapter (B867038) for use with any
110/120V electrical outlet

◗

Serial cable for transferring pictures to your
Windows PC

◗

PhotoPC NiMH power pack (B818051)

◗

PhotoPC NiMH battery pack (B818061)

◗

Built-in microphone to record a message for each
picture

◗

3.3V SSFDC or SmartMedia storage cards for
expanding your camera’s memory

◗

EPSON’s exclusive ColorTrue™ advanced in-camera
processing system for brilliant, vivid pictures

You can contact EPSON Accessories at (800) 873-7766
(U.S. sales only). In Canada, please call (800) 873-7766 for
dealer referral. SmartMedia storage cards and adapters are
also available from Simple Technology at (800) 4-SIMPLE.

2 Introduction

EPSON offers several options for the PhotoPC 550.
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System Requirements

Where To Get Help

To transfer pictures and sounds to your computer and edit
them, make sure your system meets these minimum
requirements:

EPSON provides customer support through the following
services:

◗

IBM-compatible PC with 486/66 or higher processor

◗

Microsoft Windows 95, Windows 3.1 or later,
Windows for Workgroups 3.11 or later, or
Windows NT 3.5 or later

◗

Serial port with standard RS-232C interface

◗

At least 16MB RAM (32MB for Windows NT)

◗

Double-speed CD-ROM drive

◗

Hard disk drive with at least 30MB free space

◗

VGA monitor with at least 256-color display
(for higher quality viewing, a 16 million-color display
is recommended)

◗

Mouse or other pointing device

Electronic support services
Service

Access

World Wide Web

From the Internet, you can reach EPSON’s
Home Page at http://www.epson.com.

EPSON Internet FTP If you have Internet FTP capability, use your
Site
Web browser (or other software for FTP
downloading) to log onto ftp.epson.com with
the user name anonymous and your e-mail
address as the password.
EPSON Download
Service

You can call the EPSON Download Service at
(800) 442-2007. Set your communications
software to 8 data bits, 1 stop bit, no parity.
Modem speed can be up to 28.8 Kbps.

EPSON Forum on
CompuServe®

Members of CompuServe can type GO EPSON
at the menu prompt to reach the Epson
America Forum. For a free introductory
CompuServe membership, call (800) 848-8199
and ask for representative #529.

If you want to play back or record new messages for your
pictures, your system must also have at least a 16-bit sound
card, speaker, and microphone.

A
B
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Automated telephone services
Service

Access

EPSON
SoundAdvice

For pre-recorded answers to commonly asked
questions about EPSON products 24 hours a
day, seven days a week, call (800) 442-2110.

EPSON FaxAdvice



EPSON Referral
Service

Access EPSON’s technical information library
by calling (800) 442-2110. You must provide a
return fax number to use this service.
For the location of your nearest Authorized
EPSON Reseller call (800) 442-2110.

EPSON also provides technical support and information on
the installation, configuration, and operation of EPSON
products. Dial (800) 922-8911, (310) 782-2600 (U.S.), or
(905) 709-9475 (Canada), 6 A.M. to 6 P.M., Pacific Time,
Monday through Friday.
Before you call, please have the following information ready:

You can purchase manuals, accessories, and parts from
EPSON Accessories at (800) 873-7766 (U.S. sales only).
In Canada, please call (800) 873-7766 for dealer referral.

Software Support
If you’ve tried Image Expert’s on-screen help and you still
have questions, contact Sierra Imaging on the Internet at
http://www.sierraimaging.com or call (800) 501-8902 for
technical support (for Windows 95 and Windows NT users,
make sure you check the Quick Tour first).

Registration
Please take a minute to fill out the registration card for the
PhotoPC 550 digital camera and mail it back to us. This
enables you to receive special information on accessories,
new products, and software upgrades. You’ll get immediate
attention if you have a problem with your PhotoPC 550.

◗

Product name

◗

Product serial number

Safety Instructions

◗

Computer configuration

◗

Description of the problem

Read all of these instructions before using your camera. Also
follow all warnings and instructions marked on the camera
and batteries.

4 Introduction
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◗

To reduce the risk of electric shock, do not remove the
camera’s cover or open any of the compartments except
as instructed in this User’s Guide.

◗

To prevent fire or electric shock, do not insert objects
into any openings in the camera.

◗

Use only the types of power sources listed in this
User’s Guide.

◗

To prevent fire or electric shock, do not expose the
camera to rain or moisture and do not use the camera
where inflammable or volatile gas is stored.

◗

Do not use a frayed or damaged power cord with the
AC adapter.

◗

If you use an extension cord with the optional AC
adapter, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the
cord’s ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not
exceed the wall outlet’s ampere rating.

◗

Remove batteries and/or unplug the camera and the AC
adapter and refer servicing to qualified service personnel
under the following conditions: if the power cord or
plug is damaged; if liquid has entered the camera; if the
camera has been dropped or its exterior has been
damaged; if the camera or its optional accessories do not
operate normally or exhibit a distinct change in
performance.

◗

Do not use the camera outdoors during adverse weather
conditions.

◗

If the camera shows unusual signs such as noise, odor, or
smoke, turn it off immediately. Remove the batteries
and/or disconnect the AC adapter, and unplug the AC
adapter from the electrical outlet.

◗

To avoid damage to the optics of the camera, do not
expose the lens to direct sunlight for extended periods of
time.

◗

Avoid sudden temperature changes, which can cause
moisture to condense on the camera. Keep the camera in
a case or bag if you need to move it from a cold

environment to a warm one. Allow time for the camera
and its optional accessories to adjust to temperature
changes before using them.

Introduction 5
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◗

Adjust only those controls that are covered by the
operating instructions.

◗

Do not attempt to service the camera yourself. Refer all
servicing to qualified service personnel.

◗

If the liquid crystal solution contained in the display
panel leaks out and gets on your hands, wash them
thoroughly with soap and water. If it gets in your eyes,
flush them immediately with water.

6 Introduction
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1 Getting Started

T
camera

hand strap

batteries

his chapter helps you get ready to use your new
PhotoPC 550. It covers the following:

◗

Unpacking your PhotoPC 550

◗

Identifying camera parts

◗

Using batteries

◗

Using the optional AC adapter

◗

Attaching the hand strap

◗

Installing your PhotoPC 550 software

Unpacking Your PhotoPC 550
software
PhotoPC 550 cable

Your PhotoPC 550 includes all the parts shown to the left.

A
B
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Identifying Camera Parts
shutter button

viewfinder

display panel
viewfinder

timer light

microphone

status
light

storage card
slot cover

lens cover
connector
cover

lens

hand strap
holder

macro on/off switch

TITLE

BACK.e

EPSON AMERICA, INC.
TITLE

front view
(lens cover is open)

ONOFF-2.eps

EPSON AMERICA, INC.

Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782-0770

1-2 Getting Started

DATE

REV> 20 Septem

DRAWN BY

Wendi Swanlund

back view

Documentation Department
20770 Madrona Avenue, Torrance, CA 90503
(310) 782-0770

DATE

REV> 3

DRAWN BY

Wendi
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display
panel
image quality
button

Using Batteries
voice
recording
button

shutter
button

The instructions in the following sections tell you how to
install and handle batteries.

Installing Batteries
S-Hi / Hi / S
VOICE
ERASE
SELF TIMER

erase
button

timer
button

Before you install the batteries, make sure the camera is
turned off (the lens cover is closed, see “Turning the Camera
On and Off” on page 2-2). Then follow these steps:

1

Turn the camera upside down with the back facing you.

2

Open the battery cover by sliding it in the direction of
the arrow, as shown below:

top view

A
B
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3

Insert all three batteries into the compartment,
positioning the + and - ends as shown below:

battery positions

Handling Batteries
When your PhotoPC 550 batteries wear out, you can replace
them with any of the following:
◗

Single-use AA alkaline batteries (Energizer brand
recommended)

◗

Single-use AA lithium batteries (longer life)

◗

Rechargeable AA NiCd batteries

◗

Rechargeable AA NiMH batteries

WARNING
To avoid the danger of fire or explosion, do not mix different
types of batteries. Do not allow the battery contacts to touch
metal objects such as coins or keys, which could short out the
battery’s circuits. Read all safety and handling instructions before

4

Close the battery cover and slide it to the right until it
snaps into place.

using batteries.

Note the following when handling batteries:

1-4 Getting Started

◗

Use the batteries that came with your camera only in
EPSON digital cameras.

◗

Do not use manganese batteries.
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◗

Replace all three batteries at the same time.

◗

If you use rechargeable NiCd batteries, replace them
with three fully charged batteries. If you find that your
batteries run out faster after you recharge them a
number of times, make sure you discharge them
completely before recharging.

◗

If the rechargeable batteries are charged in a hot
environment, or if they are charged repeatedly without
being fully discharged, they will wear out more quickly.

◗

Do not drop, puncture, disassemble, or mutilate
batteries. Do not get them wet or expose them to fire.

◗

When the camera is not used for long periods of time,
remove the batteries and store them at a low temperature
in a dry location. Store away from the reach of children.

◗
◗

To avoid fire or electric shock, do not use batteries that
are leaking or damaged in any way.
If battery acid gets in your eyes or on your skin,
immediately rinse the area with water and seek medical
treatment. If a battery is swallowed, seek medical
treatment immediately.

◗

Dispose of used batteries according to the
manufacturer’s instructions and in compliance with all
applicable laws. Contact your local government agency
for information about battery recycling and disposal.

◗

Battery life varies depending on the battery type and the
manufacturer.

Using the Optional AC Adapter
To save battery power, you can use the optional AC adapter.
This is especially useful when you are transferring pictures
and operating the camera from your computer (see
Chapter 3).
The AC adapter allows you to connect your PhotoPC 550 to
any standard 110/120V electrical outlet. The adapter powers
the camera but does not charge the batteries.
The AC adapter (product code B867038) should be available
where you bought your PhotoPC 550. You can also order it
from EPSON Accessories at (800) 873-7766 (U.S. sales
only). In Canada, call (800) 873-7766 for dealer referral.

A
B
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WARNING

2

Plug the adapter cable into the DC port on the camera.

3

Plug the AC adapter into an electrical outlet.

Use only the adapter designed for the PhotoPC 550. Using any
other adapter may cause fire, electrical shock, or injury.
Do not alter the plug on the power cable, and do not use the
adapter for any other purpose than powering your PhotoPC 550.

To avoid losing any images or settings, make sure the camera
has finished processing the images. Turn the camera off
before you connect or disconnect the AC adapter. Then
follow these steps:

1

Open the connector cover on the side of the camera.

1-6 Getting Started
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Attaching the Hand Strap
To attach the hand strap, loop the strap around the holder
on the bottom of the camera as shown below. You may need
to use the point of paper clip or similar object to push the
strap through the holder.

Installing Your PhotoPC 550
Software
PhotoPC 550 comes with everything you need to transfer
your pictures from the camera to your computer, organize
and enhance your images, and insert them into documents.
You can also record and play back messages for each picture.
The included CD-ROM has this software for your
Windows PC:
◗

Sierra Imaging Image Expert

◗

PhotoPC 550 TWAIN driver

All programs will be installed in the PhotoPC 550 folder or
directory.
NOTE
If you don’t have a CD-ROM drive, see page 1-9.

A
B
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Installing for Windows 95 or
Windows NT 4.0

Installing for Windows 3.1x or
Windows NT 3.51

Follow these steps:

Follow these steps:

1

1

Insert the CD-ROM in your drive.

2

In the Program Manager, select Run from the File
menu.

3

Type D:\SETUP. If your CD-ROM drive is not
drive D, substitute the correct letter.

4

Click OK and follow the instructions on the screen.

Insert the CD-ROM in your drive. The install program
starts automatically.
If it doesn’t start automatically, double-click
My Computer. Then double-click your CD-ROM

icon.

2

Follow the instructions on the screen.

NOTE for Windows 95 users

NOTE for Windows 95 and Windows NT users

To view the readme file, see C:\Program Files\Sierra Imaging\

After you install your software, you can run the Image Expert

PhotoPC 550\Image Expert\readme.wri. If you did a custom

Quick Tour to learn more about your camera. See page 3-6 for

installation, the readme files may be located in a different

instructions.

directory.
To uninstall Image Expert, use the Add/Remove Programs option
in the Control Panel.

1-8 Getting Started
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Making Software Installation Diskettes
If you don’t have a CD-ROM drive on your computer, you
can create Image Expert installation diskettes from the
CD-ROM using another computer that has a CD-ROM
drive.
Before you start, make sure you have five blank, formatted
diskettes for Windows 3.1 or eight for Windows 95 and
Windows NT. Then follow these steps:

1

Use the Windows Explorer (or File Manager) to access
your CD-ROM drive. (You may have to exit the Setup
program first.)

2

Double-click mkfloppy.exe.

3

Depending on which version of Windows you’re using,
select Windows 95/Windows NT or Windows 3.1.
Then select your diskette drive and click OK. Follow the
instructions on the screen to create the installation
diskettes.

A

Now you can install the PhotoPC 550 software on your
computer.

B
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2 Taking Pictures

T

aking pictures with PhotoPC 550 is similar to
using a traditional “point and shoot” camera. This
chapter tells you everything you need to know, including:

Greetings from Utah

◗

Turning the camera on and off

◗

Checking the display panel

◗

Setting image quality

◗

Taking a picture

◗

Recording messages with the microphone

◗

Using macro mode to take close-ups

◗

Taking pictures in low light conditions

◗

Taking pictures with the timer

◗

Using a tripod

◗

Erasing pictures

A
B
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Turning the Camera On and Off

Saving Power With Auto Shut-off

Before you can take pictures with PhotoPC 550, you need to
turn on the camera and check the display panel. It’s
important to be aware of the camera’s power-saving features
and the status of your batteries.

If you wait more than 60 seconds before taking a picture, the
camera turns off automatically to save battery power. There
are two ways to turn the camera back on:

To turn the camera on, slide the lens cover open.
display panel

◗

Close the lens cover and then open it again.

◗

Press the shutter button halfway down.

You can change the auto shut-off time when the camera is
connected to your computer (see page 7-4).

Checking the Display Panel
The display panel shows the camera’s current settings,
number of pictures remaining, and status of your batteries.
.

/

CLO
SE
OFF

/

The display panel on the top of the camera lights up and the
status light on the back of the camera turns green, which
indicates the camera is ready to take pictures.
To turn off the camera, slide the lens cover shut. The display
panel turns off.

2-2 Taking Pictures

voice
recording

image
quality

OPE
N O
N

macro
mode

pictures
remaining

erase

self
timer
battery status
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Checking the Battery
Before you take pictures, check the battery icon on the
control panel. The icon shows how much battery power you
have left, in the following stages.
Full battery power (or AC adapter in use)
to

Battery power is decreasing

Battery power low (time to buy new batteries)
Battery power is almost out
Change batteries
The battery icon flashes when your battery power is
completely out. At this point, you can’t take pictures until
you replace the batteries or use the AC adapter.
NOTE
When the battery power is low, image processing is less reliable.

batteries you use. Low temperatures—especially below 50 °F
(10 °C)—drain your batteries faster. See page 1-3 for battery
use instructions.

Checking the Picture Counter
The large number in the center of the display panel shows
how many additional pictures you can take. This number
depends on your image quality settings. If you change this
setting, the number will change.
When the camera’s memory is full, the number of pictures
remaining is 0. The status light on the back of the camera
turns red, and you can’t press the shutter button.
To free up some of the camera’s memory, you can erase the
pictures you don’t want to save. See page 2-10 for
information on erasing pictures using the ERASE button.
See Chapter 3 for instructions on erasing pictures in the
camera when it is connected to your computer.

A

You should use the battery icon only as a guide to estimate
remaining power. Several factors can affect battery life,
including the surrounding temperature and the type of

B
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Setting Image Quality
PhotoPC 550 has three image quality (resolution) settings:
Standard, High, and Super High.
Press the image quality button on top of the camera to cycle
from one setting to the other. The image quality icons
(shown below) appear on the display panel.

Super High (S-Hi)
Produces color images at 640 × 480 pixels with low
compression. The camera holds at least 6 snapshot
size (approximately 3.3 × 4.4 inches [83.8 × 111.8 mm])
pictures in this mode. With less compression, Super High
images are better for pictures that will be enlarged.
NOTE

Standard (S)

When you turn the camera off and back on or replace the

Produces color images at 320 × 240 pixels, with
moderate compression. The image size is smaller and
includes less detail when enlarged. This is ideal for web pages
and wallet-size pictures (the picture size is approximately
1.7 × 2.2 inches [43.2 × 55.8 mm]). The camera holds at
least 24 pictures in this mode.

batteries, the image quality setting is the last setting used. When

High (Hi)
Produces color images at 640 × 480 pixels with
standard compression. Your pictures include greater
detail and are snapshot size (approximately 3.3 × 4.4 inches
[83.8 × 111.8 mm]). The camera holds at least 12 pictures in
this mode.

2-4 Taking Pictures

you replace the batteries, the image quality setting defaults to
High.

High quality is sufficient for most purposes. Use Super High
quality if you plan to enlarge your pictures. High and Super
High resolution pictures take longer to process and will drain
batteries faster than standard images.
You can switch between the settings and mix pictures of
varying quality in the camera. The camera’s capacity for
storing images will vary accordingly. Depending on the
content of your pictures, your camera may hold more than
the numbers shown. As long as the display panel shows a
number other than zero, you can continue taking pictures.
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Taking a Picture

NOTE

Follow these steps to take a picture:

Remember that the camera shuts off automatically after

1
2

60 seconds. To turn the camera back on, close the lens

Make sure you are at least 23.6 inches (60 cm) away
from your subject.
Turn the camera on and wait until the status light turns
green.

cover and then open it or press the shutter button halfway
down.

3

Look straight through the viewfinder and center your
subject within the cross-hairs.

status light

cross-hairs
viewfinder

macro crop marks
(see page 2-7)

shutter
button

4

Hold the shutter button halfway down to lock the focus.
The status light changes from green to orange.

A
NOTE
If you do not lock the focus, your pictures may be blurry.

Taking Pictures 2-5
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5

Press the shutter button the rest of the way down to take
the picture.
Hold the camera still until it beeps and the status light
starts flashing red. The flashing red light indicates that
the camera has captured the image and is processing it.
Processing takes approximately eight seconds.

CAUTION
If you set the camera down while it is processing a picture, make
sure you handle it carefully. The camera may lose your image if
you set it down too hard.

When the light stops flashing and turns green , the image is
saved and you can take another picture. Saved images remain
in memory for at least a year, even when the camera is turned
off and the batteries are removed.

TIP
When you’re taking pictures outdoors, make sure the sun is at
your back. In very bright light (at the beach or in snow, for
example), your pictures may come out too light. You can use
Image Expert or other image editing software to correct most
over-exposure problems.

Recording Messages With the
Microphone
You can use the built-in microphone to annotate a picture
with sound or record a voice message. After you take a
picture, follow these steps to add sound to it:

1

Press the VOICE button until you hear the camera beep.
The voice icon appears on the display panel and the
status light flashes red.
voice recording
icon

2-6 Taking Pictures
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2

Hold the camera 4 to 6 inches (10.2 to 15.2 cm) away
and speak into the microphone. You can record a
message up to six seconds long. When the recording
time is up, the camera beeps twice.

After you record your message, the picture counter decreases
by one. The message is “attached” to the last picture taken.
Each message uses the same amount of memory as a highresolution picture and is stored as a .wav file.

Using Macro Mode to Take
Close-ups
You can use the camera’s macro mode to take pictures as
close as 3.9 inches (10 cm). The macro range is from 3.9 to
21.7 inches (10 to 55 cm). Follow these steps:

1

Turn the camera on.

2

Slide the macro switch so it is above the macro icon.

If you don’t like the message you recorded, you can record a
new message by pressing the VOICE button again. PhotoPC
550 automatically records over the last message.
NOTE
You cannot erase a message only; you can only record over it. If
you press the ERASE button, you erase both the image and the
attached message.
If your camera is connected to your computer, you must use the

A

computer’s microphone to record messages. See “Connecting
the Camera” on page 3-2 and “Recording New Sounds” on
page 5-9.

macro switch
macro icon

B
Taking Pictures 2-7

takepix.fm Page 8 Friday, October 10, 1997 2:38 PM

3

The macro icon appears on the display panel.

To turn off macro mode, slide the macro switch to the
left. The macro icon disappears from the display panel.

Taking Pictures in Low Light
Conditions

macro icon

4

5

Center the image in the viewfinder and press the shutter
button to capture it.

macro crop
marks

actual image
area captured

You can use PhotoPC 550 in most indoor or low light
settings. There is no need for a flash because of the camera’s
highly light sensitive CCD sensor. A good rule of thumb is if
you can read a book in the available light, you can take a
picture with PhotoPC 550.
When taking pictures in low light conditions, be sure to hold
the camera still until you hear it beep. The shutter speed may
be as slow as 1/4 of a second in low light conditions. You also
can use a tripod to hold the camera steady. See “Using a
Tripod” on page 2-9.
TIP

TIP
When centering your image in macro mode, be sure to allow
space around the image to compensate for any parallax shift
(the difference between what you see in the viewfinder and
the actual image captured).

2-8 Taking Pictures

If you take pictures under fluorescent lights, you may need to
adjust the color, contrast/brightness, or hue/saturation using
Image Expert. See Chapter 7 for instructions.

takepix.fm Page 9 Friday, October 10, 1997 2:38 PM

Taking Pictures With the Self Timer

4

Setting the timer adds about a 10-second delay between the
time you press the shutter button and the time the picture is
taken. This allows you to take a picture of yourself.

The camera beeps when the image is captured. The
status light continues to flash red as PhotoPC 550
processes the image. When the status light stops flashing
and turns green, you can take another picture.

Follow these steps to take a picture with the timer:

1

Secure the camera on a flat surface or on a tripod. (See
the next section for information on attaching the camera
to a tripod.)

2

Turn on the camera and wait until the status light turns
green.

3

Press the SELF TIMER button. The self timer icon
appears on the display panel.

The timer automatically turns off after the image is processed
or if you turn the camera off and back on.

Using a Tripod
For portraits or other studio pictures, you can attach your
PhotoPC 550 to a tripod. Follow these steps:

1
self timer icon

Press the shutter button. The timer icon on the display
panel flashes slowly for about 8 seconds. Then the icon
and the status light (on the front of the camera) flash
rapidly for about 2 seconds before the shutter is released.

Assemble and set up the tripod by following the
manufacturer’s instructions. Make sure the tripod is
well-balanced on a flat surface.

A
B
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2

Find the opening for the tripod screw on the bottom of
your camera. Carefully place the camera on the tripod.
Screw the camera on until it is firmly in place.
tripod socket

NOTE
You cannot erase a message only. You must erase both the
message and the picture.

To erase the last picture taken, down the ERASE button for
two seconds until you see the erase icon on the display panel.
TIP
Be sure to press the indentation in the center of the ERASE
button. You may need to press it with your fingernail instead of
your finger.

The icon flashes and the status light on the back of the
camera is red while the picture is erased.

3

Adjust the tripod to view your subject as desired.

Erasing Pictures
You can erase the last picture taken (along with any
accompanying audio message) or you can erase all the
pictures in the camera at once.

2-10 Taking Pictures

erase icon

To erase all the pictures in the camera, hold down the
ERASE button and then press the SELF TIMER button
until you see the erase icon.
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3 Getting Pictures Into Your Computer

W

hen you’re finished taking pictures, you can connect
the camera to your computer and download the
images. If you’re using Windows 95 or Windows NT 4.0,
you can use the Camio™ Viewer to drag a picture directly
from the camera and drop it into your project. Then you can
add the pictures to your letters, presentations, or just about
anything you create on your computer. This chapter
describes the following:
◗

Connecting the camera

◗

Getting images and sound with the Camio Viewer
(Windows 95 and Windows NT 4.0 only)

◗

Getting images and sound with Image Expert

◗

Getting images into TWAIN applications

A
B
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Connecting the Camera

2

Note the following before you start:
◗

If you have the optional AC adapter, you can conserve
battery life by using it when you connect the camera to
your computer. See page 1-5 for instructions.

◗

The camera’s auto shut-off feature takes place after
5 minutes of inactivity when the camera is connected to
your computer. (If you are using the optional AC
adapter, the camera remains on.) To turn the camera
back on, close the lens cover and then open it again.
(You can change the auto shut-off time period if you
want. See page 7-4 for instructions.)

◗

When you connect the camera, make sure your system is
not exposed to sources of electromagnetic interference,
such as stereo speakers or the base units of cordless
telephones.

Make sure you have the serial cable that came with your
camera. Then follow these steps:

1

Turn off the camera and your computer.

3-2 Getting Pictures Into Your Computer

Locate a serial port on the back of your computer. You
may have two serial ports labeled COM1 and COM2, or
the ports may be labeled with icons. If you have two
serial ports available, use COM1 (port 1) to connect
your camera.
NOTE
If you have a 25-pin serial port, you can use a 9- to 25-pin
adapter.

3

Line up the serial connector on the cable with one of the
serial ports on your computer, and insert the connector.
Then tighten the screws.
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4

Open the connector cover on the side of the camera.

6

Turn on the camera and your computer. The connect
icon appears on the display panel.

connect icon

Getting Images and Sounds With the
Camio Viewer
5

Insert the other end of the cable into the camera’s serial
port.

PhotoPC 550 provides several different ways to transfer your
pictures from the camera to your computer. The Camio
Viewer, which runs only under Windows 95 and Windows
NT 4.0, is a quick and easy way to get pictures from the
camera. You can transfer all images and sounds to your
computer, or just display the pictures in the camera. Then
you can drag a picture directly into a presentation or
document.
If you haven’t installed your software, do it now, following
the instructions on page 1-7.

A
B
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First you need to connect the camera to your computer as
described in the previous section. Then follow these steps:

1

Double-click the camera icon
your Windows 95 Taskbar.

2

Choose one of the following options:
◗

on the right end of

View images in the Camera

Displays a filmstrip of your pictures. You can then
select an image to drag and drop into a document or
presentation.

You see the Camio Viewer Startup Options dialog box:
◗

Copy all images from the Camera to the
Computer

Click to see the
pictures in your
camera.

Transfers your pictures and sounds to an album
(folder) on your hard disk drive. You can then select
an image to drag and drop.
◗

Copy all images and delete them from the
Camera

Transfers your pictures and sounds to an album
(folder) on your hard disk drive and deletes them
NOTE
If you clicked the sound icon

instead (available if your

system is configured for sound), see page 5-6 for
information.

3-4 Getting Pictures Into Your Computer

from the camera. You can then select an image to
drag and drop.
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NOTE
Dragging and dropping an image with the Camio Viewer
works only with OLE 2.0-compliant applications running
under Windows 95 and Windows NT 4.0.
You cannot drag and drop sound into your document.

3

Dragging and Dropping a Picture Into a
Document
Follow these steps if you chose View images in the
Camera:

1

Click OK. Your pictures appear in a strip of thumbnail
images:

Continue with the steps in one of the following sections,
depending on the option you chose in step 2.

Transferring Images Before Placing Them
Follow these steps if you chose Copy all images:

1

Click OK to copy your pictures to an album named with
the current date. Or, type a new name for the album and
click OK. Your pictures are transferred one by one. They
appear in a strip of thumbnail images, as shown on the
previous page.
indicates audio

2

Follow steps 2 and 3 in the next section to drag and drop
a picture into a document or other project.

2

Open the application and document where you want to
use the picture.

Getting Pictures Into Your Computer 3-5
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3

Click the picture you want to use. Without releasing the
mouse button, drag the picture to your document.
When your pointer is over the location where you want
the picture to appear, release the mouse button. The
picture is downloaded from the camera, and it appears
in your document.
If you want to edit or modify the picture, just doubleclick it to bring up the Image Expert menus and toolbar.
For more information about the Camio Viewer, choose
Quick Tour from the Image Expert Help menu in
Window 95 or Windows NT.

NOTE
Although these instructions and the accompanying illustrations
show Image Expert running under Windows 95, you can follow
the same steps on a Windows 3.1 or Windows NT system.

1

Start Image Expert. Under Windows 95, click Start,
and then point to Programs, PhotoPC 550, Image
Expert.
If you’re using Windows 95 and Windows NT, you see
a Quick Tour screen like the following:

NOTE
When you drag and drop with the Camio Viewer, your picture is
embedded into your document and also automatically saved to
the default Image Expert directory under the current date.

Getting Images and Sound With
Image Expert
Image Expert lets you view small thumbnail images of your
pictures, and then quickly transfer them to an album (folder)
on your hard disk drive.

3-6 Getting Pictures Into Your Computer

If you’re using Windows 3.1, skip to step 3.
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2

Click on any of the topics for an animated
demonstration of what you can do with PhotoPC 550
and Image Expert.

3

To skip the tour and download your pictures and sound,
click Close. You see a window like the following:

Click View Pictures in the Camera. You see a
window displaying “filmstrips” of your images. (If you
see an error message instead, follow the instructions on
page 3-9.)

Click to start
downloading
your pictures.
Click to see
the pictures
in your
camera.

indicates audio
message

4

Click Get All to transfer all the images. You can also
click an individual image to select it. The Get All
button changes to Get Selected.
NOTE
To select a range of images, hold down the Shift key while

NOTE
To open Quick Tour again, select Quick Tour from the Help
menu.

A

you click.
To select several images individually, hold down the Ctrl key
while you click on the images.

Getting Pictures Into Your Computer 3-7

B

computer.fm Page 8 Friday, October 10, 1997 2:39 PM

You see a Select Album window like the following:

5

Type here if you
want to rename
your album.

Click Open to begin transferring your pictures. A
window like the following appears to show you the
progress of each image.

download status
of current picture
download status of
all pictures selected

Click if you want to stop
transferring images.

Image Expert will automatically create an album (folder)
for your pictures with the current date as its name. You
can type your own name for the album if you want, or
choose an existing album.

NOTE
If you select only one picture to download, there is only one
status bar.

6

3-8 Getting Pictures Into Your Computer

When you’re finished, close the filmstrip window. You
see a message asking if you want to delete all the files in
the camera.
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7

If you want to make room for more pictures in your
camera, click Yes.

Your pictures are displayed in an album of thumbnails. You
can double-click an image to open it in Image Expert. You
can display your images one by one; edit, print, and copy
them to diskettes; or place them in your documents and
presentations. See the following chapters for instructions.
You can also use the Help menu for more information.

Follow these steps to make sure your camera is connected
correctly:

1

Make sure the camera is turned on and has not shut off
automatically. If it has, turn it off and then back on
again by closing and opening the lens cover.

2

Check the cable and make sure the connections to the
camera and computer are secure.

3

Make sure your batteries have enough power or your
AC adapter is connected.

4

Click Retry. If you see the Connection Failed message
again, click Setup.

What To Do if You See an Error Message
When you click the button to view images in the camera,
you may see a message like the following:

You see the following dialog box:

A
B
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5

Select another port if necessary. In most cases, it is best
to leave the Port setting at Auto because Image Expert
can detect the camera connection automatically.
If you have a serial device connected to one port and an
internal modem on the other, you can try setting the
Port to COM3 or COM4.

6

7

Select a slower speed. Image Expert automatically
chooses the fastest speed that works with your system,
but this may actually be too fast for the configuration of
your port. If you are using Windows 95 or
Windows NT, try lowering the speed to 57600. If you
are using Windows 3.1, try lowering the speed to 57600
or 38400. You may need to experiment to choose the
best speed for your system.

Getting Images Into TWAIN
Applications
If you use Photoshop or other TWAIN-compliant
applications, you can transfer your pictures directly into your
program from the camera. Follow the steps below.
NOTE
If your images have audio messages attached to them, you must
use Image Expert to download them. TWAIN does not support
audio transfer.

1

Start your application.

2

From the File menu, choose Import, then Select
TWAIN_32 Source (or Acquire, then TWAIN_32
Select Source).

When you are finished, click OK.

NOTE
You may need to select TWAIN instead of TWAIN_32 in
some applications, especially those in Windows 3.1.

3

3-10 Getting Pictures Into Your Computer

Choose PhotoPC 550 as the TWAIN source.
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4
5

From the File menu, choose Import, then TWAIN_32
(or Acquire, then TWAIN_32 Acquire).
The PhotoPC 550 Twain Driver window appears, with
“thumbnail” images of your pictures, as shown below.
(If you do not see the Twain Driver window, it may be
in the background. Minimize your application window
to see the Twain Driver window. If you see a message
that says The camera is not responding, see the
following section.)

Click to transfer
your picture(s).

NOTE
Some applications import only one picture at a time.

7

If you want to delete images from your camera, select
.
the image and then click Delete

8

If necessary, click Close to exit and return to your
application.
You see the imported picture or pictures in the work
area.

What To Do if the Camera Is Not
Responding
When you try to acquire pictures from the camera, you may
see a screen like the following:

A
6

Select the picture you want and click Get Selected to
transfer the picture. Or, click Get All to transfer all the
pictures.

B
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Follow these steps to fix your camera connection:

1

Make sure the camera is turned on and has not shut off
automatically. If it has, turn it off and then back on
again by closing and opening the lens cover.

2

Check the cable and make sure the connections to the
camera and computer are secure.

3

Make sure your batteries have enough power, or your
AC adapter is connected.

4

Click Test Connection. If you see the same screen,
continue with step 5.

5

Select another port if necessary. In most cases, it is best
to leave the Port setting at Auto.
If you have a serial device connected to one port and an
internal modem on the other, you can try COM3 or
COM4.

6

Select a slower speed. You may need to experiment to
choose the best speed.

7

Click Test Connection again. If you still don’t see
your pictures, see Chapter 9 for more troubleshooting
tips.

3-12 Getting Pictures Into Your Computer
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4 Getting Pictures Into Your Documents

P

hotoPC 550 provides several methods for getting
your pictures into presentations, letters, and other
projects. You can drag and drop a picture from an Image
Expert album into a document or presentation. You can also
import an image into your application, or copy and paste it.
This chapter describes the following:
◗

Importing images into documents

◗

Using drag and drop from an album (Windows 95 and
Windows NT 4.0 only)

◗

Getting images with copy and paste

◗

Converting file formats (Windows 95 and
Windows NT 4.0 only)

A
B
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NOTE
Although most of the instructions and illustrations in this chapter

Follow these steps:

1

Start Image Expert as described in Chapter 3.

2

Click View Pictures from an Existing Album.

apply to Windows 95, you can follow the same steps on a
different version of Windows.

Or, from the Image Expert screen, click the
or select Open Album from
Open Album button
the File menu. You see a dialog box like the following.

Using Drag and Drop From an Album
Once you have transferred your pictures into albums, you
can easily drag and drop them into documents or other
projects if you are using Windows 95 or Windows NT 4.0. If
you want to drag and drop from the Camio Viewer instead
of Image Expert, see page 3-5.
NOTE
Dragging and dropping an image into a document works only with
OLE 2.0-compliant applications, such as later versions of
Microsoft Word  or PowerPoint. Depending on how well your
application supports OLE 2.0, your images may not look as good
when you drag and drop them as when you import them.
You cannot drag and drop sound into your document.

3

4-2 Getting Pictures Into Your Documents

Locate the album you want and double-click the album
name to open it.
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4

Start your word processor or other application.

8

5

Open the document where you want to use the picture.
You should have both the Image Expert album and the
document displayed on your screen, as shown:

If you want to edit or modify the picture, just double-click
on it to bring up the Image Expert menus and toolbar.

Release the mouse button. The picture appears in your
project or document.

Importing Images and Sound Into
Documents
Once your pictures are transferred and saved on your hard
drive, you can import them into your applications. You may
need to convert your images if your application can’t import
JPEG files. See “Converting File Formats” on page 4-5.
NOTE
Your picture may display poor image quality after you import it if
your computer doesn’t support more than 256 colors. However,
in most cases it will print correctly.

6

Click the image you want.

7

While holding down the mouse button, drag the image
to the location where you want it in your document.

Follow these steps to import a PhotoPC 550 picture into
your document:

A

1

Start your application.

B

2

Open the document where you want to use the picture.
Getting Pictures Into Your Documents 4-3
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3

Select the point where you want to place your picture.

4

Select Picture from the Insert menu. (In some
applications you may need to select a different
command, such as Import Picture, which is usually in
the File menu.)

6

Click OK (or Insert, Import, or whatever command
your application uses) to insert your picture. The picture
appears in your document.

An Insert Picture dialog box appears:

NOTE
In some applications, you can add a frame around the picture if

5

Locate and select the image you want to insert. In some
applications you can see a preview of your picture. (If
you have sound attached to your image, you may need
to import it separately, depending on your application.)

4-4 Getting Pictures Into Your Documents

you want to move it around on the page or resize it. In other
applications, you create a frame first, and then place the picture in
it. For instructions, see your application’s online help or
documentation.
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Getting Images With Copy and Paste

2

Open the image you want to convert.

You can use this method to place a picture in just about any
type of document or project. Follow these steps:

3

From the File menu, select Save As. The Save As
dialog box appears:

1

Open your picture in Image Expert.

2

Click the Copy button or select Copy from the Edit
menu.

3

Start your word processor or other application.

4

Open the document where you want to use the picture.

5

Choose Paste (or Paste Special) from the Edit menu.
A copy of the picture appears in your document.

Click if you want to
create a new folder.

Click if you want to
choose a different folder.

Converting File Formats
PhotoPC 550 pictures are JPEG files. If your word processor
or other application doesn’t support the JPEG format, you
can use the Save As feature of Image Expert to convert your
files.

Type a name for
your photo.

A
4

Follow these steps:

1

Click to choose
the file type.

Type a new file name, if you want.

B

Start Image Expert.
Getting Pictures Into Your Documents 4-5
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5

6

Select the file type from the pull-down menu. You can
choose any of the following formats:
◗

JPEG

◗

Bitmap (BMP)

◗

TIFF

◗

Targa (TGA)

◗

PC Paintbrush (PCX)

Click Save.

4-6 Getting Pictures Into Your Documents
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5 Working With Pictures and Sounds in
Albums

Y

ou can use Image Expert albums to organize your
pictures and display or print them in various ways. You
can also copy an album to diskette, and use your own
pictures as your screen saver or desktop wallpaper. If your
computer is configured for sound, you can listen to the
messages you recorded with PhotoPC 550 or record new
messages. You may even be able to e-mail a picture directly
from Image Expert. This chapter covers the following:
◗

Using albums to display and organize pictures and
sounds

◗

Viewing picture information

◗

Printing pictures and albums

◗

Playing back sounds

◗

Adding new sounds to a downloaded image

◗

Displaying albums as slide shows

◗

Copying an album or image to diskette (Windows 95
and Windows NT only)

◗

Setting an album as your screen saver (Windows 95 and
Windows NT 4.0 only)

◗

Setting an image as your desktop wallpaper
(Windows 95 and Windows NT only)

◗

Sending pictures and sound by e-mail (Windows 95
only)

A
B
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Using Albums

Organizing Pictures in Albums

Image Expert albums provide a convenient way to access and
view your pictures.

Although Image Expert initially sorts your pictures by date,
you can easily drag and drop images between albums to
organize them by subject matter or in any way you want.

Click here to change a
picture’s name.

Follow these steps to copy or move images from one album
to another:

1

Here are some of the things you can do with albums:
◗

Use the Edit menu to rename or delete an album.

◗

Add or remove pictures by moving them to or from
another album.

◗

Add sounds to or remove sounds from existing images.

◗

Change a picture’s name by clicking on it and typing a
new name.

◗

Rearrange an album by selecting Sort By Name or
Sort By Date from the View menu.

5-2 Working With Pictures and Sounds in Albums

Open the album where the pictures are located and the
album you want to copy the images to. If you want to
create a new album, click the New Album button
or select New Album from the File menu.
If you selected New Album, enter a name in the New
Album box. The new album opens, but is empty.

existing
album
new
album
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2

3

Select the image or images you want to move or copy.
Hold down the Ctrl or Shift key to select multiple
images.
To copy images, click inside one of the selected images
and hold down the mouse button.
To move images, click inside one of the selected images,
hold down the mouse button, and hold down the Shift
key.

4

While holding down the mouse (and Shift key), drag
the image(s) to the other album until it is highlighted.

5

Let go of the mouse button (and key).

Viewing Picture Information
You can display information about any image file and the
camera settings that were used to capture it. Follow these
steps:

1

Click the picture to select it or open the image by
double-clicking it.

2

Click the Properties button
or select Properties
from the Image menu. You see information like the
following:

The images are copied or moved to the album. You can
sort the pictures and save or rename the new album.
All PhotoPC 550 images are captured as 24-bit JPEG files.

A
B
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3

Click the Camera Settings tab to display information
like the following:

Printing an Image
You can print your picture actual size or enlarged, and add a
title or footer to the page. Follow these steps:

1

Open the image you want to print.

2

Click the Page Setup button
Setup from the file menu.

or choose Page

The Page Setup dialog box appears:
NOTE
If you are viewing an image from another application, the

Click if you want to reposition your picture.

camera settings tab may not be available.

4

Click another image to view its information, or close the
Properties box.

If you want to listen to the sound attached to your image, see
“Playing Back Sounds” on page 5-6.

Click to see how your page will look.
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3

Set any of the following options and click OK:
◗

Click Actual Size to keep your picture the same
size or click Fit to Page to stretch your picture to
fill the page.

NOTE
If you click Fit to Page, your picture loses detail because it is
being enlarged.

◗

4

Type in a title for the top of the page. Click the
Font button to change the font properties.

◗

Choose what you want to appear at the bottom of
the page from the Page Footer list.

◗

If you want to change the position of your picture
on the page, click the Margins tab and enter new
values for the margins.

◗

Click Preview to see what your printout will look
like.

Click the Print button
or choose Print from the File
menu to print your picture.

Printing an Album or Selected
Images
You can print a contact sheet containing thumbnail images
of all the pictures in your album, or you can set the number
of pictures printed on each page. You can also add a page
title or footer, and print identifying information for each
picture. Follow these steps:

1

Open the album you want to print. Select individual
images if you don’t want to print the whole album.

2

Click the Page Setup button
or choose
Page Setup from the file menu. The album Page Setup
dialog box appears:

Click to set
font for
labels, title,
or footer.

A
B
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3

Set any of the following options and click OK:

Playing Back Sounds

◗

When you open an image that has audio attached to it
(indicated by a musical note), the audio clip automatically
plays if your system is configured for sound.

Choose Print Contact Sheet or Print Images.
For a Contact Sheet, Image Expert prints your
pictures at thumbnail size and fits as many as
possible on the page.
If you choose Print Images, you can set the number
of images you want printed on each page.

◗

◗

Type in a title for the top of the page.

◗

Choose what you want to appear at the bottom of
the page from the Page Footer list.

◗

If you want to change the position of your picture
on the page, click the Margins tab and enter new
values for the margins.

◗

4

Select a label for the images. You can select from
combinations of name, date, and time, or select
none.

Click Preview to see what your printout will look
like.

Click the Print button
or choose Print from the File
menu to print out your album or selected pictures.
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indicates audio
message

You can also select the image with sound and use the Audio
menu buttons to listen to it.

play or restart
pause
stop
record
edit
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Follow these steps to see a sound wave of your audio clip:

Changing the Volume

1

Select an image that has an audio clip.

2

Click the Audio Edit button
, or choose Edit from
the Audio menu. The sound wave window opens.

To change the volume of your audio play back, you can
access the audio controls of your system by double clicking
the sound icon on the right end of your Windows 95
Taskbar. The Volume Control dialog box appears. Use the
slide bars to adjust the sound levels.

3

Click the Play button
Audio menu.

, or select Play from the

Replaying a Section of an Audio Clip
There are two ways to select a part of the audio clip to replay:
◗

◗

Click the bottom of the sound wave at the beginning of
the part you want to hear. When you click the Play
button, you hear the audio clip from the arrow to the
end of the clip.
Click your mouse and drag the cursor over the section
you want to hear. The selected section is highlighted.
Click the Play button to hear the highlighted section.

NOTE
The controls available in the Volume Control dialog box depend on

A

your system configuration. For more information on Volume
Controls, see your computer documentation.

Working With Pictures and Sounds in Albums 5-7
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To change the playback or recording volume, right click the
sound icon . The Audio Properties dialog box opens:

If you want to add sound to your downloaded images, see the
following sections.

Adding and Modifying Sounds
in a Downloaded Image
After you download your image, you can add an audio clip to
it. You can also edit, erase, or add to an existing message.

Cutting and Pasting Sounds
Follow these steps:

Move the sliders left or right to change the volume.
NOTE
The Preferred device is set by your system. For more information,
see your computer documentation.
You can also access this dialog box by selecting System
Properties from the Image Expert Audio menu.

5-8 Working With Pictures and Sounds in Albums

1

Select the image that has the sound you want to edit.

2

Click the Audio Edit button
, or choose Edit from
the Audio menu. The sound wave window opens.
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3

Click your mouse and drag the cursor over the section
you want to cut or copy. The selected section is
highlighted.

Recording New Sounds
You can add sounds to an image that doesn’t have it or you
can add sounds to an existing audio image. Follow the steps
below.
NOTE
Your computer must have a microphone and 16-bit sound card to
add sounds to a downloaded image.

4

Select Cut or Copy from the Edit menu.

1

Select the image that you want to add sound to.

5

Select the image that you want to attach the audio to
and paste in the selected audio clip.

2

Click the Record button
or select Record from the
Audio menu to open the Record dialog box:

NOTE
When you paste an audio clip, it replaces the current sound. If
you want to add to an existing sound, use the Record Additional
option in the Audio Record dialog box.

A
B
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3

4

Select the option you want:

Deleting Sounds

◗

To delete an audio clip, follow these steps:

To add sound to an image that doesn’t have sound
or to replace the current sound, choose Record
New.

◗

To add additional sound to an existing audio clip,
choose Record Additional.

◗

To end your recording, choose Stop.

◗

To listen to your new recording, choose Play New.

◗

To listen to your original recording, choose Play
Original.

If you like your new recording, click OK. Otherwise,
click Cancel to delete the new recording and exit the
Record window.
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1

Select the image with the sound you want to delete.

2

Select Delete from the Edit menu or press the Delete
key on your keyboard. The following screen appears:

3

Check the Only delete the audio box, then click Yes.
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Displaying Albums as Slide Shows
When you display an album as a slide show, you can have it
play automatically with various transition effects between
images. Follow these steps:

1

Open your album.

2

Click the Slide Show button
or select
Slide Show from the View menu.

To hear the audio for a selected image, click the Play
Audio button (this option is not available if the slide
show is currently running).

4

If you want to change the appearance of your slide show,
click the Options button. The Slide Show Options
dialog box appears:

The first image appears on your screen with the slide
show controls, as shown:

view next
view previous

3

play

stop

options
play audio

close

Click the Play button to see the slide show. If your
images have sound attached to them and your computer
is configured for sound, you will also hear the audio
portion of the slide show.

A
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5

6

Set any of the following options and click OK:

Copying to Diskette

◗

To stretch your pictures across the whole screen,
click Fit to Screen.

◗

To change the display period for each picture,
change the number in the Seconds Between
Pictures box.

◗

If you are using Windows 95 or Windows NT, you can copy
whole albums or individual images with sound to diskettes.
You can also include a multimedia player, so your friends
and business associates can view your pictures on their
computers. This makes your images and albums completely
portable. Follow these steps:

To play the slide show only once, click
Continuous Repeat to deselect it.

◗

To hide the titles of your pictures, click Show
Titles to deselect it.

◗

To turn off the fades and dissolves that play
between pictures, click Show Transition Effects
to deselect it.

◗

To turn off the audio portion of the slide show,
click Play Sounds to deselect it.

Click the Exit button to stop the slide show.
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1

Insert a diskette into your diskette drive.

2

Open the album you want to copy.

3

If you only want to include some of your images, select
the images you want to add. To select more than one
image, hold down the Ctrl or Shift key while selecting
your image.
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4

Select Save to Floppy from the File menu. You see the
following dialog box:

NOTE
If your album is too large for one diskette, you can copy it to
multiple diskettes. When you copy the files to another
computer, the album will be in one piece again. You can also
use Zip™ disks or other large-format storage media. Make
sure your diskette is not write-protected before you try to
copy.

8
5
6

7

Make sure your diskette drive appears in the Copy
images to: box.
If you want to include a slide show player to view the
pictures, make sure Include Slide Show Player is
checked.
If you want to copy the whole album, click Selected
Images Only to deselect it.

Click OK to copy your files.

Viewing the Pictures on Diskette
You can run the slide show from the diskette or install the
slide show player on another computer.
◗

To run the slide show, double-click the player. The
pictures appear on your screen with the slide show
controls. See page 5-11 for instructions on setting slide
show options.

◗

To install the player, double-click the installer icon and
follow the instructions on the screen.

A
B
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Using an Album as a Screen Saver

Setting an Image as Wallpaper

It’s easy to make your own screen saver with your favorite
pictures. This option is available only if you are using
Windows 95 or Windows NT. Follow these steps:

You can use one of your own pictures as the background for
your desktop. This option is available only if you are using
Windows 95 or Windows NT. Follow these steps:

1

Open the album you want to use.

1

2

Choose Set Screen Saver from the File menu. Image
Expert asks you to confirm your choice.

Open the image you want to use, or select it in an
album.

2

Choose Set As Wallpaper from the File menu. The
following dialog box appears.

3

Click Yes.
Windows will play a slide show of your album whenever
your system is idle.

NOTE
The screen saver slide show doesn’t include controls. If you want
to change the way your pictures are displayed, you have to use
the screen saver settings in your Control Panel. See your
Click to remove
existing wallpaper.

Windows documentation or help system for more information.

3
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Choose Center to place your picture in the middle of
the screen or Tile to fill the screen with copies of your
picture.
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4

If you want the image to be stretched across the whole
screen, click Resize to fit screen.

5

Click Yes. (If you change your mind, click Remove
Wallpaper.)

Before you start, make sure your modem and Internet service
are working correctly and your e-mail application is
configured. Then follow these steps:

1

Select or open the image(s) you want to send. Some
e-mail systems may limit the number of images you can
send in a single message.

2

Choose Send from the file menu. You see the Choose
Profile dialog box on the right.

You can minimize Image Expert to see your new
wallpaper.

Sending Pictures and Sound by
E-mail
If you are using Windows 95 or Windows NT 4.0, you can
send a picture directly from Image Expert if your e-mail
application complies with the MAPI (messaging application
programming interface) standard. For example, you can use
Inbox or Microsoft Exchange. You need to set up Microsoft
Exchange to work with your Internet service.
NOTE
If you can’t e-mail pictures directly from Image Expert, you can
always send an e-mail message as you do normally and attach
one or more image and sound files.

Click to configure
your Internet
service for
Microsoft
Exchange.

3

Choose the profile you want to use.
Click New if your Internet service has not been set up
to work with Microsoft Exchange. For more
information about setting up Microsoft Exchange, see
your Windows documentation or help system.
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4

Click OK. Your e-mail application opens, and the
images you selected appear as attachments.

5

Type the e-mail address where you’re sending the
picture(s). You can also type in a subject heading and
message if you want.

6

When your e-mail is ready, click whatever button your
application uses to send. The picture(s) are mailed, your
e-mail application closes, and Image Expert becomes
active again.
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6 Editing Images

Y

ou can edit your images to enhance their appearance;
crop, rotate, and resize them; or create special effects.
This chapter describes the following Image Expert features
you can use to modify your images:

original image

image with ripple
effect applied

image with glass
blocks effect applied

image with invert
effect applied

◗

Viewing and selecting

◗

Applying Quick Fix

◗

Correcting

◗

Cropping

◗

Resizing and changing resolution

◗

Rotating

◗

Flipping

◗

Applying special effects

◗

Changing the number of colors

A
B
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Viewing and Selecting

◗

When your image is displayed in an album, you can rotate it
or do a quick fix. However, to use any other editing features,
you need to open the image by double-clicking it or selecting
Open Image from the File menu.

Use one of the three selection tools to isolate a part of
your image before you edit it. Click the tool, then click
and drag on your image to select the portion you want to
work on.

◗

Click Select All to select your entire image or all the
images in an album.

◗

Click Select None to deselect your image or images.

Before you edit your image, you may want to use the Zoom
and selection tools on the left side of your screen.

NOTE
Zoom

For more information about any of the editing tools described in
this chapter, use the Help menu.

Select Rectangle
Select Ellipse
Select Freehand
Select All

Applying Quick Fix
The easiest way to improve your image is to have Image
Expert automatically “correct” it with the Quick Fix
command. You can click the Quick Fix tool
or select
Quick Fix from the Image menu.

Select None

◗

Click the Zoom tool, and then click anywhere on your
image to enlarge your view. Hold down the Ctrl key and
click to zoom out.

6-2 Editing Images

If you don’t like the results, simply select Undo Quick Fix
from the Edit menu. (If you Quick Fix an image displayed in
an album, you can’t undo it.)
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Correcting
To fine-tune an image, click the Corrections tool
or
choose Corrections from the Image menu. You see a dialog
box like the following:

Click and drag to adjust the
division between the original
and edited preview.

Click the tabs at the top of the screen to make these kinds of
corrections:
◗

Brightness and Contrast
For adjusting the amount of light in your image and the
difference between light and dark areas.

◗

Color
For correcting color casts and adjusting the balance of
cyan (blue), magenta (red), and yellow in your picture.

◗

Hue/Saturation
For adjusting colors around the “color wheel,” the
strength or purity of color, and the brightness of your
image.

◗

Sharpness
For emphasizing or de-emphasizing edges.

◗

Equalization
For increasing detail in dark areas of your image.

Each dialog box “tab” includes sliders for quickly and easily
correcting your image. Simply move the slide indicator left
or right to make your edit.

Editing Images 6-3
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The preview window shows your image with the original
view on the left and the corrected image on the right. If you
want to adjust the division between the original and edited
image, click and drag the triangle below the image. You can
also zoom in on your image to see more detail.
◗

Click Apply to make your changes on the current “tab.”
Your edited image becomes your new original and the
slide indicators move to the center of the range.

◗

Click OK to save the changes you made on all the
Corrections tabs and return to the main screen.

◗

Click Cancel to cancel the changes on the current tab
and return to the main screen.

3

selected area

Cropping
If you want to save only part of your image, use the crop
function to cut out the rest of the image. Follow these steps:

1

Open the image you want to modify.

2

Click one of the selection tools on the left side of your
screen.

6-4 Editing Images

Click and drag the mouse over the area you want to save.
A dashed border indicates the area you selected.

4

If you change your mind about which part of the image
to crop, simply click anywhere in the image and repeat
step 3.

5

Click the Crop tool
or choose Crop from the Image
menu. The part of the image that was outside the dashed
line disappears.
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Resizing and Changing Resolution
You can resize your image in two ways: changing the printed
size, or changing the image size in pixels. You can also
change the resolution or image quality.

Click the tab if you want to change the image size in pixels.
You see a dialog box like the following:

Choose Resize from the Image menu. You see a dialog box
like the following:

These
settings work
together: if
you change
one, the
others also
change.

NOTE

Uncheck if you want to
distort your image.

If you change the size of the image in pixels, the physical size
of the image also changes, but not the resolution. Follow
these guidelines when you resize:
◗

High and Super High images from your PhotoPC 550 have a
resolution of 144 pixels per inch.

◗

To enlarge your picture and retain its quality, increase
the image size in pixels until the rectangle in the preview
window looks the right size. The file size of your image
will increase at the same time.
To make an image smaller, you can simply change its
physical size. The resolution automatically increases.
Editing Images 6-5
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Rotating

A rectangular outline of your image and an arrow
appear, as shown:

You can click the Rotate tool
to quickly rotate a picture
to the right. (If you rotate an image displayed in an album,
you can’t undo it.)
For more options, select Rotate from the Image menu. You
can choose one of the following:
◗

Left (90 degrees counterclockwise)

◗

Right (90 degrees clockwise)

◗

Exact (specify the degree of rotation)

◗

Free (interactive rotation, as described below)

If you want to experiment with rotation, choose Free and
follow these steps:

1

Click on your image and hold down the mouse. Your
pointer turns into the rotation tool.

6-6 Editing Images

2

Move the pointer to rotate your image.

3

Release the mouse when your picture is at the angle you
want.
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Flipping

Click the tabs at the top of the screen to add these effects:

You can reverse your image by selecting Flip Horizontal
from the Image menu. This is useful for printing iron-on
transfers. Select Flip Vertical to turn your image upside
down.

◗

Ripples
For an underwater effect. You can create whirlpool
effects or just a slight distortion.

◗

Glass blocks
You can change the number and size of the blocks.

◗

Edges
To soften outlines and decrease the amount of details.
You can also blend the image into a light or dark
background.

◗

Fisheye
To distort the center of the image, as if looking through
a glass ball.

◗

Invert
To create a negative of your image.

Applying Special Effects
To transform or distort your images in interesting ways,
choose Effects from the Image menu. You see a dialog box
like the following:

Each dialog box “tab” includes sliders for applying the effect.
Slide the indicator to the right to increase the distortion. You
can combine several filters for even more unusual effects.

A
B
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The preview window shows your image with the original
view on the left and the distorted image on the right. If you
want to adjust the division between the original and filtered
image, click and drag the triangle below the image. You can
also zoom in on your image to see more detail.
◗

Click Apply to make your changes on the current “tab.”
Your distorted image becomes your new original and the
slide indicators move to the center of the range.

◗

Click OK to save the changes you made on all the Effects
tabs and return to the main workspace.

◗

Click Cancel to cancel the changes on the current tab
and return to the main workspace.

Changing the Number of Colors
To convert the color format of your image, select Number
of Colors from the Image menu. You can choose from the
following:
◗

24 Bit (Millions of Colors)
The way your images are originally captured.

◗

8 Bit (256 Colors)
For low-resolution display systems or certain types of
software.

◗

Grayscale (256 Shades of Gray)
For printing in black and white.

NOTE
JPEG files are 24-bit images and cannot be saved as 8 bit.

If you save your image as 8 Bit or Grayscale, you cannot
switch back to 24 Bit color.
Unlike the other editing options, changing the number of
colors applies to the whole image. You can’t change the
number of colors for a selected area only.

6-8 Editing Images
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7 Managing the Camera From the
Computer

W

hen the camera is connected to your computer, you
can take pictures with a live preview on your
computer screen to help you frame each shot. You can also
set the camera’s clock.
This chapter covers the following:
◗

Taking pictures from your computer

◗

Adjusting camera settings from your computer

Taking Pictures From Your Computer
When you connect the camera and take pictures from your
computer, you see a live preview of each shot before you
capture it. You can control all the camera settings from your
computer, and even set the shutter speed.

NOTE
If you have the optional AC adapter, you can save battery power
by using it when you connect the camera to your computer. The
AC adapter should be available where you bought your PhotoPC
550, or you can order it from EPSON. See page 1-5 for more
information.

Follow these steps to take pictures from your computer:

1
2

Connect the camera to your computer as described in
Chapter 3.
Position the camera facing the subject. Using a tripod
will give you the most control when setting up your
shots. See page 2-9 for instructions.
Managing the Camera From the Computer 7-1
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3

Turn on both your camera and your computer system.

4

Start Image Expert as described on page 3-6.

5

Click the Camera Controls button
Controls from the Camera menu.

NOTE
The camera’s auto shut-off feature takes place after
5 minutes of inactivity when the camera is connected to

or choose

your computer and you are not using the optional AC
adapter. To turn the camera back on, close the lens cover
and then open it again.

You see a dialog box like the following:

6
Click to
capture
the image
you see.

Click Continuous Update to activate the live preview
feature. The image you see is updated every 8 to 10
seconds, depending on your connection speed. You may
need to move the camera or your subject until you see
the image you want to capture.
The colors in your live preview image may appear pale

Click to change
the image
quality setting.

and washed-out. This will not affect the colors in your
actual picture.
NOTE
You can also update the preview window by clicking on it.
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NOTE

Using the Self Timer

operate these features through your computer.

You can use this feature to have your computer take a picture
automatically, after a delay period that you can set. This
allows you to take self-portraits and other special shots.

The only feature you can control through the camera is

Follow these steps:

When the camera is connected to your computer, you can’t
use the shutter or control buttons on the camera. You must

macro mode. If you switch to or from macro mode, the
mode automatically changes, but you must close and reopen
the Camera Controls window to update the window.

7

When your shot is ready, click Take Picture. The
image is captured and processed.

8

Click Close when you’re finished taking pictures from
your computer.

1

Open the Camera Controls dialog box.

2

Click Self Timer. You see the following dialog box:

3

Enter a number for the delay period you want to use.
You can set up to a 99-second delay.

4

Click Start/Stop to start the countdown and take the
picture. The red timer light on the camera remains on
for the delay period you entered. Then the light flashes
rapidly for 2 seconds and the shutter is released.

NOTE
The live preview feature will quickly drain your batteries. Make
sure you turn it off as soon as you’re finished or use the optional
AC adapter.

The camera beeps and processes your picture.
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Setting the Shutter Speed
Most of the time, PhotoPC 550 adjusts the shutter speed
automatically. However, when you take pictures from your
computer, you can adjust the speed manually. This lets you
use special lighting effects and even take “stop-action”
pictures.
On the Camera Controls window, click the arrow and select
the speed you want from the pull-down list.

Adjusting Camera Settings From
Your Computer
You can use Image Expert to change the following camera
settings:
◗

Time

◗

Date

◗

Power down time (Auto Shutoff)

◗

Camera ID

◗

Connection Port

◗

Connection Speed

Follow these steps:

1

Connect the camera to your computer as described in
Chapter 3.

2

Turn on your camera and computer.

3

Start Image Expert as described on page 3-6.

Click to select a
shutter speed.
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4

Click the Camera Setup button to display the Camera
Setup dialog box:

◗

Enter new values in either of the Power Down Time
boxes if you want to change the camera’s automatic
shut-off period.

◗

If you want to adjust your port settings, click the
Camera Connection button. You see the Connection
dialog box:

◗
◗

◗

Enter a new Camera ID if you want to change the
default. This might be useful if you have more than one
camera and you want to be able to have its ID recorded
in your picture data.
Type the correct time or date in the Computer Time
and Camera Time boxes if you need to change them.
Or, click Set Camera to Computer Time to have
your camera automatically synchronized to your
computer.

Select another port if you want to change your
connection. In most cases, it is best to leave the
Port setting at Auto because Image Expert can

detect the camera connection automatically.
◗

Select a different communication speed. Image
Expert automatically chooses the fastest speed that
works with your system. This may actually be too
fast for the configuration of your port. You may

A

need to experiment to choose the best speed.

B
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8 Using SmartMedia Cards

Y

ou can use 3.3V SSFDC or SmartMedia removable
storage cards (2MB and up) to increase the storage
capacity of your PhotoPC 550 camera. They are easy to
install and remove, and you can easily download the images
to your computer.
NOTE
When you install a storage card, the camera stores and displays

This chapter covers the following:
◗

Installing a storage card

◗

Removing a storage card

◗

Getting images from a card to your computer

◗

Formatting a storage card

SmartMedia cards increase the camera’s picture storage
capacity as shown in the following table.

pictures on the card, rather than in its internal memory.

Number of pictures (minimum capacity)
3.3V SmartMedia removable storage cards and adapters
should be available where you bought your PhotoPC 550
camera. You also can purchase them from EPSON
Accessories at (800) 873-7766 or Simple Technology at
(800) 4-SIMPLE.

Image Quality

Internal Memory

2MB Card

4MB Card

Standard

24

73

147

High

12

36

73

Super High

6

18

36

A
B
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Installing a Storage Card

2

Insert the card all the way into the storage card slot.

3

Close the storage card slot cover.

4

Turn the camera on. The card icon and the number of
pictures you can store in the storage card appears on the
camera’s display panel.

Before you start, make sure the camera is turned off. Then
follow these steps:

1

Open the storage card slot cover on the side of the
camera.

storage card
icon
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NOTE

CAUTION

When a storage card is installed, you may notice a delay between

Never remove the card while the camera is accessing it. Data in

the time you press the shutter button and when the camera

the card may be lost or damaged. Avoid using or storing the card

beeps. To avoid blurring, hold the camera still until it beeps.

in dusty places, in direct sunlight, or in hot or humid places.

Removing a Storage Card

Transferring Images and Sound to
Your Computer

Make sure the camera is turned off. Then open the cover to
the storage card slot and gently pull out the storage card.

There are two ways you can transfer the pictures and sound
on a SmartMedia card to your computer:
◗

Use the serial port on your computer. This is the same
method as transferring pictures stored in the camera’s
memory; see “Getting Images and Sound With Image
Expert” on page 3-6.

◗

Use a PCMCIA adapter, which allows you to access the
images on SmartMedia cards directly from your
computer.

A

When you are not using your SmartMedia card, always store
it in its case or inside the camera to avoid damaging it.

B
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Using a PCMCIA Adapter

2

Insert the adapter into your computer’s PCMCIA slot.

To use the PCMCIA adapter, your computer must have a
PCMCIA slot. Refer to the instructions that came with your
adapter or follow these steps to use an adapter:

1

Insert the storage card all the way into the adapter, as
shown below:

To remove the storage card from the adapter, press the eject
tab at the end of the card.

eject tab
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Transferring Pictures

NOTE

Once the adapter and card are installed in your computer’s
PCMCIA slot, you can transfer pictures by simply copying
them to your hard drive. This is the fastest way to get
pictures into your computer.

Be sure to press the indentation in the center of the ERASE

◗

In Windows 95, use My Computer or the Windows
Explorer to drag and drop image files to your hard drive.

Technical Support Department at (800) 4-SIMPLE.

◗

In Windows 3.1, use the Windows File Manager to copy
image files to your hard drive.

button. You may need to press it with your fingernail instead of
your finger.
If you are unable to format a Simple Technology card, contact the

You can also download the pictures using Image Expert.

Formatting a Storage Card
Most SmartMedia cards are already formatted when you buy
them. If you are unable to add images to your SmartMedia
card, you may need to format the card. Follow these steps:

1

Install the storage card in the camera.

2

Hold down the ERASE button and then press the
S-Hi/Hi/S button for 2 seconds or until the “pictures
remaining” number changes.

A
B
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9 Maintenance and Troubleshooting

Y

our PhotoPC 550 camera is easy to take care of, and
any problems you may have are easy to solve. This
chapter includes the following sections:
◗

Cleaning the camera

◗

Storing the camera

◗

Solving camera problems

◗

Solving picture problems

◗

Solving sound problems

Cleaning the Camera
◗

Use a clean, dry cloth to wipe the camera free of dust.

◗

Don’t use harsh or abrasive cleaners. Don’t use liquid or
aerosol cleaners.

◗

To clean the lens, first blow off any loose dust or dirt.
Then breathe on the lens and wipe off all moisture with
a soft, lint-free cloth or lens cleaning tissue. To avoid
scratching the lens, don’t press too hard.

◗

If necessary, clean the battery contacts with a dry cloth.

NOTE
Before you perform any maintenance procedures, be sure to read

Storing the Camera

the Safety Instructions in the Introduction.

◗

Keep the lens covered (power turned off) and store the
camera in a carrying case or bag when you’re not
using it.

Maintenance and Troubleshooting 9-1
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◗

◗

Avoid sudden temperature changes, which can cause
moisture to condense on the camera. Keep the camera in
a case or bag if you need to move it from a cold
environment to a warm one. Allow time for the camera
and its optional accessories to adjust to temperature
changes before using them.

Solving Camera Problems

◗

Make sure the lens cover is open all the way.

When the camera is not used for long periods of time,
remove the batteries and store them at a low temperature
in a dry location. This prevents camera damage from
battery leaks or corrosion.

◗

Make sure the storage card slot cover is closed.

◗

The camera may have shut off automatically. Close and
open the lens cover to turn the power back on.

◗

Check the batteries and make sure they are installed
correctly. If the batteries no longer have a charge,
recharge or replace them.

◗

If you are using the AC adapter, make sure it is plugged
into the camera and into a working outlet.

Do not store the camera in the following locations:
◗

Where it will be exposed to direct sunlight, for example,
on a car dashboard

Before you call for help, check this list of problems and
possible solutions:
The camera has no power.

◗

Near bright sources of light or high humidity

◗

Near heat sources or in a closed car or trunk

You can’t take a picture with the camera.

◗

In areas of excessive dirt or dust

◗

◗

Where it will be exposed to strong vibrations or
magnetic fields

9-2 Maintenance and Troubleshooting

The camera may be full. Check the picture counter on
the display panel. Erase some pictures (see page 2-10), or
transfer the pictures to your computer and then erase
them (see Chapter 3). Or, install a SmartMedia card to
store more pictures (see Chapter 8).
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◗

The camera may be connected to your computer. When
it’s connected, you can’t use any of the controls on the
camera itself. See Chapter 7 for instructions on taking
pictures from your computer.

The “pictures remaining” number on the display panel
doesn’t decrease after you take a picture or record a
message.
◗

Your camera is operating correctly. The total number of
pictures you can store depends on your pictures’ content
and messages’ length. So the number doesn’t always
change, especially when you’re using standard image
quality.

You get an error message when you try to transfer your
pictures to the computer.
◗

Make sure the cable is connected correctly as described
in Chapter 3.

◗

Make sure your camera is turned on and the batteries
have enough power.

◗

Check the serial port settings in your Image Expert
software. You may need to change the Port and Speed
serial connection settings to Auto. On some older
computers, you may need to lower the baud rate. Try
setting the baud rate to 38,400 or lower.

◗

Make sure the port to which your camera is connected is
properly configured and that the Base I/O port address
and the Interrupt Request Number (IRQ) assigned to
the port are not in conflict with any other devices.

◗

Check the port setting in your Windows Control panel.
You may need to set your port to a faster speed, lower
the FIFO buffer size (advanced serial port
configuration), or adjust the speed in your software. See
Chapter 7 for more information.

◗

Avoid opening or working with other software
applications while the camera and computer are
communicating.

You can’t install an album from a diskette to your
Windows NT 3.51 system.
◗

Try copying the album to your computer instead.

Maintenance and Troubleshooting 9-3
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You are unable to drag and drop pictures into a document.
◗

If you’re using Windows 3.1, this method of getting
pictures into your documents may not be reliable. Try
inserting, importing or using copy and paste.

◗

If you are using Excel or PowerPoint, you may need to
upgrade the version of your software.

◗

If your system has less than 16MB RAM, you may not
be able to use drag and drop. Make sure you don’t run
too many applications at the same time. You may need
to add memory to your system or use another method of
getting pictures into your documents.

You get an error message when you use the Image Expert
Save to Floppy feature.
◗

You get a TWAIN error message when you try to transfer
images with Adobe Photoshop.
◗

If you’re using Windows 3.1, make sure you select
TWAIN (not TWAIN_32) as your source.

◗

If you’re using Windows NT 4.0, you may need to
upgrade your software to Photoshop 4.0. Earlier versions
of Photoshop do not support Windows NT 4.0. Or you
may need to upgrade your computer if it is slower than
100 MHz or if you have less than 32MB of RAM.

The pictures transfer to your computer too slowly.
◗

◗

If your system has less than 16MB RAM, the transfer
speed may be slow. Try using virtual memory. See your
computer documentation or help system for more
information.
Check the port setting in your Windows Control panel.
You may need to set your port to a faster speed. See your
Windows documentation or help system for more
information.
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Make sure the diskette you’re using is not writeprotected.

You are unable to format or use a SmartMedia storage card
with your camera.
◗

Make sure you’re using a 3.3V SSFDC or SmartMedia
card. Other cards will not work with PhotoPC 550. If
you’re using a Simple Technology card, call the
Technical Support Department at (800) 4-SIMPLE.
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Your notebook computer can’t access a SmartMedia storage
card.
◗

If you’re using an IBM Thinkpad,® you need to adjust
the configuration of your PCMCIA port. Change the
Global Settings to Auto. For more information, contact
the manufacturer of your notebook computer.

Solving Picture Problems
If you’re not satisfied with some of the pictures you get from
the PhotoPC 550, you may need to adjust some of the
camera settings. Read the suggestions below.
Your pictures display poor image quality on the screen or
when you print them out.
◗

PhotoPC 550 captures images in 24-bit color
(16.7 million colors). Your pictures will not display
maximum image quality if your monitor or computer’s
video controller doesn’t support this color depth. You
may need to upgrade your system to achieve the best
possible image quality.

◗

If your pictures look better on the screen than when you
print them out, you may need to upgrade your printer.
EPSON Stylus® color ink jet printers, for example,
provide excellent image quality.

◗

If you used drag and drop to insert your pictures, they
may appear grainy. Try importing them into your
documents instead.

The colors in your picture don’t look right.
◗

When you take pictures under certain artificial lighting
conditions, the colors may be slightly distorted. You can
use your Image Expert software to adjust the colors, as
described in Chapter 7.

Your picture is blurry or out of focus.
◗

◗

Make sure your subject is within the camera’s range. You
should be at least 2 feet (61 cm) away for most pictures.
You can take a picture as close as 4 inches (10.2 cm) in
macro mode.
Make sure you press the shutter button halfway down to
lock the focus and then press down completely to take
the picture.
Maintenance and Troubleshooting 9-5
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◗

Make sure you hold the camera steady and your subject
isn’t moving.

◗

In low lighting conditions, try using a tripod to hold the
camera steady. See page 2-9 for instructions.

◗

If you want to take a picture of a moving subject, you
can increase the shutter speed while the camera is
connected to your computer. For more information, see
Chapter 7.

Your picture is too light (overexposed).
◗

If you’re facing a bright light source, you may need to
shoot your picture from a different angle.

◗

Use Image Expert to adjust the picture’s brightness as
described in Chapter 7.

Part of your picture is missing.
◗

Make sure you’re not blocking the lens with your finger,
hand strap, clothing, or other object.

Your picture is too dark (underexposed).
◗

Lighting conditions may be too dark for the camera’s
range.

◗

Use Image Expert to adjust the picture’s brightness and
contrast as described in Chapter 7.

◗

If you’re using the macro mode to take a close-up
picture, be sure to provide adequate lighting for your
subject, since the camera’s smallest aperture setting (F8)
is automatically selected in this mode.

9-6 Maintenance and Troubleshooting

A horizontal or vertical red line appears on your picture.
◗

Red lines are caused by glare. Avoid photographing
shiny surfaces that reflect excessive amounts of light into
your lens.

The wrong date and/or time are displayed on your pictures.
◗

Whenever you change the batteries in your camera you
need to reset the clock. You can set the camera’s clock
from your computer. See Chapter 7 for more
information.
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Your pictures don’t look as good as they used to.
◗

Your camera’s lens may be dirty or dusty. Try cleaning it
by following the instructions on page 9-1.

The area captured in the picture is different from what you
saw in the viewfinder.
◗

Make sure you look straight through the viewfinder.

◗

You may get parallax error when using macro mode due
to the offset between the viewfinder and lens. Use the
macro frame marks as a guideline to center close-up
pictures.

Solving Sound Problems
When you cut and paste in a new sound, your old sound
disappeared.
◗

The paste option replaces the current sound; it is not an
“insert” option. See page 5-9 for instructions on adding
sound to an existing audio clip.

A
B
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A Specifications
Camera

Power
Sources

3 AA batteries (single-use alkaline, lithium
or rechargeable NiCd or NiMH)
Optional AC adapter (B867038)

Battery life

At least 300 pictures including download
time.

Physical Dimensions
Width

4.2 in (106.5 mm)

Height

2.6 in (66.8 mm)

Depth

1.5 in (37.2 mm)

Weight

5.4 oz (153 g), without batteries

Safety Specifications
Conforms to FCC specifications.
FCC Declaration of Conformity on file.

Technical
Product type

CCD (charged coupled device)
still frame fixed focus camera

Image size

Super high, 640 × 480 pixels
(low compression)
High, 640 × 480 pixels
(standard compression)
Standard, 320 × 240 pixels

Specifications A-1
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DPI

144 pixels per inch

Bit depth

16 million colors, 24-bit

CCD

1/3 inch progressive scan 640 × 480 pixels

Serial interface

2.5 mm mini terminal (to camera)
RS-232C compatible (to computer)

Serial communication Up to 115Kbps
speed
Internal memory

Photographic
Lens

f = 6 mm F2.8/8 (equivalent to a 43 mm
lens on a 35 mm camera)

Range

23.6 inches (60 cm) to infinity (normal
mode)
3.9 to 21.7 inches (10 to 55 cm, macro
mode)

Sensitivity

Equivalent to ISO 100

Exposure control

Program auto exposure

1MB flash memory
White balance

TTL automatic white balance

Optional expansion 3.3V SSFDC or SmartMedia cards
memory

Shutter

Automatic electric iris with mechanical
shutter, 1/4 second to 1/1000 second

Environmental

Viewfinder

Optical, with centering crosshair and edge
border

Focus

Fixed focus

Aperture

F2.8/8.0

Temperature

Operating: 32 to 104°F (0 to 40°C)
Non-operating: -4 to 140°F (-20 to 60°C)

Humidity

Operating: 30 to 90% (non-condensing)
Non-operating: 10 to 90%
(non-condensing)

A-2 Specifications
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Microphone
Frequency response 200Hz to 2.3Hz at -30DB
400Hz to 1.3Hz at -20DB

Optional AC Adapter
Physical Dimensions
Width

1.97 inches (50 mm)

Height

1.18 inches (30 mm)
1.85 inches (47 mm) including pins

Depth

3.74 inches (95 mm)

Technical
Output

DC 7V/2.0A

Input

110 to 120V AC, 50 to 60Hz

A
B
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Index
A

B

AC adapter, 2, 1-5 to 1-6, 2-3, 3-2, A-3
Accessories, 2, 8-1 to 8-5
Acquiring photos, TWAIN programs, 3-10 to 3-11
Adjusting camera settings, 2-4, 7-4 to 7-5
Albums
copying to diskette, 5-12 to 5-13
displaying as slide show, 5-11 to 5-12
dragging pictures from, 4-2 to 4-3
making screen saver, 5-14
organizing pictures, 5-2 to 5-3
printing, 5-4 to 5-6
using, 5-2
Attaching hand strap, 1-7
Audio, see Sound
Automatic shut-off, 2-2, 7-2, 7-5

Batteries
accessories, 2
checking, 2-3
handling, 1-4 to 1-5
installing, 1-3 to 1-4
specifications, A-1
Battery icon, 2-3
Bitmap (BMP) files, 4-6
Brightness, correcting images, 6-3 to 6-4

C
Cable, serial, 3-2 to 3-3
Camera settings, adjusting, 7-4 to 7-5
Camio Viewer, 3-3 to 3-6
Caring for camera, 9-1 to 9-2
CCD (charge coupled device), 2

A
B
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CD-ROM, installing software, 1-7 to 1-9
Cleaning camera, 9-1
Close-up pictures, 2-7
Color correcting, 6-3 to 6-4
Color depth, 6-8
CompuServe, 3
Computer, connecting camera, 3-2 to 3-3
Contrast, correcting, 6-3 to 6-4
Copying pictures
into documents, 4-5
to diskette, 5-12 to 5-13
Cropping images, 6-4

D
Deleting sounds, 5-10
Diskettes, copying pictures, 5-12 to 5-13
Display panel, 2-2
Distorting images, 6-7 to 6-8
Documents, getting pictures into, 3-3 to 3-6, 4-1 to 4-5
Download Service, 3
Downloading pictures, 3-3 to 3-9
Drag and drop
with Camio Viewer, 3-5
with Image Expert, 4-2 to 4-3

2 Index

E
Edges, softening, 6-7
Editing
images, 6-1 to 6-8
sounds, 5-8 to 5-10
Environmental specifications, A-2
EPSON
Accessories, 2
Electronic support services, 3 to 4
help, 3 to 4
registration, 4
World Wide Web site, 3
Equalization, 6-3
Erasing pictures
using computer, 3-4, 3-8, 3-11
using ERASE button, 2-10
Erasing sounds, 2-7, 5-10
Error messages, 3-9 to 3-10, 3-11, 9-3, 9-4

F
FaxAdvice service, 4
Features, 2
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Files
converting, 4-5 to 4-6
JPEG, 4-3, 4-5 to 4-6
resizing, 6-5
type, 4-6
viewing information, 5-3 to 5-4
Fisheye effect, 6-7
Flipping images, 6-7
Floppy disk adapter, 8-1, 8-3 to 8-5
FTP, 3

G
Glass blocks effect, 6-7

H
Hand strap, attaching, 1-7
Handling batteries, 1-4 to 1-5
Help, EPSON, 3 to 4

I
Image Expert
albums, 4-2 to 4-3, 5-2 to 5-13
camera settings, changing, 7-4 to 7-5
Camio Viewer, 3-3 to 3-6
color correcting, 6-3 to 6-4
color depth, changing, 6-8

copying pictures to diskette, 5-12 to 5-13
correcting images, 6-3 to 6-4
cropping, 6-4
editing pictures, 6-1 to 6-8
e-mailing pictures, 5-15 to 5-16
error messages, 3-9 to 3-10
flipping images, 6-7
picture information, 5-3 to 5-4
printing, 5-4 to 5-6
Quick Fix, 6-2
Quick Tour, 3-6
resizing images, 6-5
resolution, changing, 6-5
rotating, 6-6
screen saver, 5-14
selection tools, 6-2
shutter speed, setting, 7-4
slide shows, 5-11 to 5-12
special effects, 6-7 to 6-8
support, 4
taking pictures from computer, 7-1 to 7-3
transferring pictures, 3-6 to 3-9
wallpaper, 5-14
zoom tool, 6-2
Images, see Pictures
Importing photos, TWAIN programs, 3-10 to 3-11
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Installing
batteries, 1-3 to 1-4
software, 1-7 to 1-9
Internet, 3
Invert effect, 6-7
Inverting images, 6-7 to 6-8

J
JPEG files, 4-3, 4-5 to 4-6

L
Low light conditions, 2-8

M
Maintenance, 9-1 to 9-2
Memory capacity, 8-1
Memory cards, see SmartMedia cards
Microphone
specifications, A-3
using, 2-6 to 2-7

N
Negative images, 6-7

4 Index

P
Parallax, 2-8
PCX files, 4-6
Photographic specifications, A-2
PhotoPC 550 camera
AC adapter, using with, 1-5 to 1-6, 2-3
auto shut-off, 2-2, 7-2, 7-5
cleaning, 9-1
connecting to computer, 3-2 to 3-3
display panel, 2-2
features, 2
maintaining, 9-1 to 9-2
picture counter, 2-3
problem solving, 9-2 to 9-5
self timer, 2-9
software, 2, 1-7 to 1-9
storing, 9-1 to 9-2
tripod, attaching to, 2-9
turning on and off, 2-2
unpacking, 1-1
Photos, see Pictures
Physical dimensions, A-1
PICT files, 4-6
Picture counter, 2-3
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Pictures
capturing from computer, 7-1 to 7-3
close-up, 2-7
color correcting, 6-3 to 6-4
color depth, changing, 6-8
copying to diskette, 5-12 to 5-13
correcting, 6-2 to 6-4
counter, 2-3
cropping, 6-4
downloading, 3-3 to 3-9
editing, 6-1 to 6-8
e-mailing, 5-15 to 5-16
erasing, 2-10, 3-4, 3-8, 3-11
flipping, 6-7
inserting in documents, 3-3 to 3-6, 4-1 to 4-5
inverting, 6-7 to 6-8
organizing in albums, 5-2 to 5-3
printing, 5-4 to 5-6
problems, solving, 9-5 to 9-7
resizing, 6-5
rotating, 6-6
screen saver, 5-14
selecting sections, 6-2 to 6-4
slide shows, 5-11 to 5-12

special effects, 6-7 to 6-8
storage capacity of camera, 8-1
transferring from camera, 3-3 to 3-9
transferring from storage card, 8-3 to 8-5
viewing information, 5-3 to 5-4
wallpaper, 5-14
Power
AC adapter, 1-5 to 1-6, 2-3, A-3
battery, see Batteries
camera specifications, A-1
problems, 9-2
saving, 2-2
Printing pictures, 5-4 to 5-6
Problem solving
camera, 3-9 to 3-10, 9-2 to 9-5
picture, 9-5 to 9-7
sound, 9-7

Q
Quick Fix, 6-2
Quick Tour, 3-6

A

R
RAM, system requirements, 3
Registration, 4
Resizing files, 6-5

B
Index 5
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Resolution, changing, 6-5
Ripples effect, 6-7
Rotating pictures, 6-6

S
Safety instructions, 4 to 6
Safety specifications, A-1
Save to Floppy option, 5-13
Self Timer, 2-9, 7-3
Serial cable, 3-2 to 3-3
Sharpness, adjusting, 6-3
Shut-off, automatic, 2-2, 7-2, 7-5
Shutter speed, setting, 7-4
Shutter, snapping, 2-5
Simple Technology, 2, 8-5, 9-4
Slide shows, 5-11 to 5-12
SmartMedia cards, 2
capacity, 8-1
formatting, 8-5
installing, 8-1
problem solving, 8-5, 9-4
removing from adapter, 8-4
removing from camera, 8-3
transferring images, 8-3 to 8-5
Snapping the shutter, 2-5
Software, installing, 1-7 to 1-9

6 Index

Sound
editing, 5-8 to 5-10
playing back, 5-6 to 5-8
problems, solving, 9-7
recording, 2-6 to 2-7, 5-9 to 5-10
system requirements, 3
SoundAdvice, 4
Sounds
erasing, 5-10
Special effects, 6-7 to 6-8
Specifications, A-1 to A-3
SSFDC (solid state floppy disc card), see SmartMedia cards
Storage cards, see SmartMedia cards
Storing camera, 9-1 to 9-2
Strap, attaching, 1-7
Support
EPSON, 3 to 4
Sierra Imaging, 4
System requirements, 3

T
Taking pictures
close-up, 2-7
using computer, 7-1 to 7-3
with the self timer, 2-9
with the viewfinder, 2-5
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Targa (TGA) files, 4-6
Technical support, 3 to 4
TIFF files, 4-6
Timer, see Self Timer
Tripod, 2-9
Troubleshooting, 9-2 to 9-7
Turning camera on and off, 2-2
Twain driver, 1-7
TWAIN programs, acquiring photos, 3-10 to 3-11

U
Unpacking the camera, 1-1

W
World Wide Web, 3

Z
Zoom tool, 6-2
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EPSON AMERICA, INC.
LIMITED WARRANTY
What is Covered: Epson America, Inc. (“Epson”) warrants to the first end-user
customer of the product enclosed with this limited warranty statement, that the
product if purchased and used in the United States or Canada, conforms to the
manufacturer’s specifications and will be free from defects in workmanship and
materials for a period of one year from the date of original purchase. EPSON
warrants that the EPSON product is manufactured from new components and parts
or like-new components and parts which perform like new and meet the EPSON
standard of quality.
What Epson Will Do To Correct Problems: Should your EPSON product prove
defective during the warranty period, please call the EPSON Connection at
800-922-8911 for warranty repair instructions and return authorization, if required.
Epson will, at its option, repair or replace on an exchange basis the defective unit,
without charge for parts or labor. If the product requires repair or replacement,
package it in its original container or an equivalent, along with proof of the date of
original purchase. When warranty service involves the exchange of the product or of a
part, the item replaced becomes EPSON property. The exchanged product or part
may be new or previously repaired to the EPSON standard of quality. Exchange or
replacement products or parts assume the remaining warranty period of the product
covered by this limited warranty.
What This Warranty Does Not Cover: This warranty covers only normal consumer
use in the United States and Canada. This warranty does not cover damage to the
EPSON product caused by parts or supplies not manufactured, distributed or
certified by EPSON. This warranty does not cover third party parts, components or
peripheral devices added to the EPSON product after its shipment from EPSON.
EPSON is not responsible for warranty service should the EPSON label or logo or the
rating label or serial number be removed or should the product fail to be properly
maintained or fail to function properly as a result of misuse, abuse, improper
installation, neglect, improper shipping, damage caused by disasters such as fire,
flood, and lightning, improper electrical current, software problems, interaction with
non-EPSON products, or service other than by an EPSON Authorized Servicer.

Packaging and shipping costs incurred in presenting your EPSON product for
warranty service are your responsibility. Shipping costs from the EPSON repair
facility will be EPSON’s responsibility. If a claimed defect cannot be identified or
reproduced in service, you will be held responsible for costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE
AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES
ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE.
UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS
MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS
PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA,
INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS,
INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE
USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER
RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL
THEORY.
In Canada, warranties include both warranties and conditions.
Some jurisdictions do not allow limitations on how long an implied warranty lasts
and some jurisdictions do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitations and exclusions may not apply to you.
This warranty gives you specific legal rights, and you may also have other rights which
vary from jurisdiction to jurisdiction.
To locate the EPSON Authorized Reseller nearest you call:
(800) 922-8911
or write to:
Epson America, Inc. • P. O. Box 2842 • Torrance, CA 90509-2842 • MS:CS1
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